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Access WKU “TopNet” at:
http://topnet.wku.edu

Type the address in the address field of your browser — Works best with Internet
Explorer but will work with Safari, Firefox and Chrome.

General Information

Admissions

Future Students
General Financial Aid
Course Catalog
Schedule of Classes

Colonnade/General Education
Crosswalk

Registration Guide

TopNet Need Help?

Use your WKU email to login.  How to Login

Campus Directory

WKU Homepage « Frequently Asked Questions (FAQ)
TopNet Login

TopNet Login R .

Retirees, Alumni, or Not Currently

Registered Students

« For assistance with W-2s, please contact
Payroll at 270-745-5365.

« For assistance with Student Tax Forms such
as 1098-T, please contact Student Billing at
270-745-6381

« For official transcripts, refer to our Official
Transcript Request page for more
information.

Click the TopNet Login
Sign in with your WKU email and password.

< jennifer.robbins@wku.edu

Sign in

https://www.wku.edu/accounts

Enter password

https://www.wku.edu/accounts

Sign in another way

Having login issues? Contact WKU ITS Service
Desk at 270-745-7000.

Having login issues? Contact WKU ITS Service
Desk at 270-745-7000.
Q Sign-in options

If you need assistance with logging in, please go to
https://www.wku.edu/its/accounts/manage/ or contact the ITS Service Desk at 270-745-
7000.



http://topnet.wku.edu/
https://www.wku.edu/its/accounts/manage/

TOPNET MAIN MENU
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' Search ACCESSIBILITY SITE MAP HELP EXIT

Faculty Services  Advisors & Student Data Inquiry Employee Services Personal Information ~ Student Conduct Menu Finance Self-Service Misc Admin
Main Menu

Faculty Services
Obtain a detail schedule, Schedule by day and time, detail class list, summary class list, final grades, drop students for non-attendance, or registration overides

Advisors & Student Data Inquiry

Options include: Student Academic Transcript, View Student Information, View Student Schedule, Registration Add/Drop, View Student Address(es) and Phone(s), View Student E-mail Address(es), View / Update Student Advising Holds, Tax Notification.
Employee Services

View Benefits and Deductions, Pay Information, Tax Forms, Vacation and Medical Leave Balances
Financial Services

Review financial documents

Student Conduct System

Update and maintain student conduct system records

Personal Information

View or update your address(es), phone number(s), and e-mail address(es). View procedure for making a name change and/or social security number change. Change your PIN.
Faculty/Staff Purchasing Big Red Dollars

For Faculty/Staff to purchase Big Red Dollars with a Credit Card

Faculty/Staff Purchasing Dining Dollars

For Faculty/Staff to purchase Dining Dollars with a Credit Card

Faculty/Staff Meal Plan Registration

For Faculty/Staff to purchase a Meal Plan and pay by credit card

Miscellaneous Admin Menu

Miscellaneous Administration Menu

WKU On Demand/FAM Term Schedule Update

Update the WKU On Demand/FAM Term Schedule dates.

Study Abroad Maintenance Form

Update Study Abroad codes and student information.

Study Abroad Add Form

Housing Room Request Office Form

Student Check In/Out of Hall

Checking Students In/Out of Hall

ATP Maintenance Form

Faculy/Staff Purchase a Talisman Yearbook
For Faculty/Staff to purchase a Talisman Yearbook with a Credit Card

RELEASE: 8.6 v

The information available to you in the main menu depends on the role you have at
WKU. For example, if your role is faculty, you would have access to the following four
options:

“Faculty Services”

“Advising and Student Data Inquiry”
“‘Employee Services”

“Personal Information”

hWON=

In some instances, an individual may carry several roles at WKU. They may be a
faculty member, staff and a student, in which case they would also have access to
“Student Services”.

Plus, there will be other menu links for different roles and processes at WKU as
developed.




SELECT THE “FACULTY SERVICES” OPTION

Faculty Services Menu will appear (As applications are developed you will see those
links added to your account). It is always best if you select a term when you start the
TopNet process.

' Search ACCESSIBILITY SITE MAP HELP EXIT
Faculty Services i loyee Services Personal Information  Student Conduct Menu Finance Self-Service Misc Admin
Main Menu

Faculty Services

Obtain a detail schedule, Schedule by day and time, detail class list, summary class list, final grades, drop students for non-attendance, or registration overides

Advisors & Student Data Inquiry

Options include: Student Academic Transcript, View Student Information, View Student Schedule, Registration Add/Drop, View Student Address(es) and Phone(s), View Student E-mail Address(es), View / Update Student Advising Holds, Tax Notification
Employee Services
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Term Selection

It is best to make a Term Selection before you try any other link.

L==1

Student Services  Financial Aid ~Faculty Services Advisors & Student Data Inquiry Employee Services Personal Information WebTailor Menu  Finance Self-Service Misc Admin
Faculty Services

Term Selection  “mu———
CRN Selection

Faculty Detail Schedule

Faculty Schedule by Day and Time

Class List

Summary Class List With Drops

Final Grades

Change of Grade

Registration Overrides

Office Hours

Course Syllabi Maintenance

Drop for Non-Attendance Worksheet

Course Calendar

Schedule of Classes and "Lookup Any Class Roster”
Athlete Grade Review

KAP Grade Review

Forensics Grade Review

Course Adoptions

Select Term.

Select Term

Spring 2026
EECEERELH v Winter 2026
Fall 2025

Summer 2025
Spring 2025
RELEASE: 8.7.1 Winter 2025

Fall 2024
RPN Summer 2024

Spring 2024
Winter 2024




From the drop-down box select the term needed. The Registrar’s office will change the
default term based on their timetable.

Once you select the Term click the Submit Term button.

You will be returned to the Faculty Services Menu.
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Student Services  Financial Aid Faculty Services Advisors & Student Data Inquiry Employee Services Personal Information WebTailor Menu  Finance Self-Service Misc Admin
Faculty Services

Term Selection

CRN Selection

Faculty Detail Schedule

Faculty Schedule by Day and Time
Class List (SSB9)

Detail Class List

Summary Class List

Summary Class List With Drops
Final Grades

Change of Grade

Registration Overrides

Office Hours

Course Syllabi Maintenance

Drop for Non-Attendance Worksheet
Course Calendar

Schedule of Classes and "Lookup Any Class Roster"
Athlete Grade Review

KAP Grade Review

Forensics Grade Review

Course Adoptions

RELEASE: 8.1

CRN SELECTION

Click the CRN (Course Reference Number) Selection link from the Menu.
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Search RETURN TOMENU SITE MAP HELP EXIT

Student Services  Financial Aid Faculty Services ~Advisors & Student Data Inquiry Employee Services Personal Information  Finance Self-Service

Faculty Services

Term Selection

CRN Selection —
Faculty Detail Schedule

Faculty Schedule by Day and Time

Use the drop-down box to select the course you wish to work with from the list of
courses you are assigned. (Note: Your Department must enter the information in
Banner for you to have access to the CRN.)



Select a CRN for
&R Please select the CRN you wish to access, or select a different term from the menu.

v ART AND POWER - 12750

INTRODUCTION LITERATURE - 13124

RELEASE: 8.7.1

You will be returned to the Faculty Services Menu.

Faculty Detail Schedule

List of all the information for the courses.

Faculty and Advisors Faculty Detail Schedule

Faculty Detail Schedule

Term CRN

Select ) Select

@ Use this page to view your detailed schedule.

Select by Term and CRN.

z AIWKU
Faculty and Advisors Faculty Detail Schedule

Faculty Detail Schedule

Term CRN

Winter 2026 - 202605 D ART 317 700 ART AND POWER 12750 (12) .

LY

Jennifer Robbi

@ Use this page to view your detailed schedule.

Course : ART 317 700 ART AND POWER 12750

Associated Term CRN

Winter 2026 12750

College Department
Arts & Letters Art and Design
Campus Override

Web No

Status

Open

Part of Term
w2

Roster

Classlist

Available for registration
10/13/2025 - 01/06/2026

Credits
3

Course Level

Graduate, Undergraduate



Scheduled Meeting Times v

Type £ FromTime ¢ ToTime C  Days Where C  startDate C  EndDate £  Schedule Type ¢ Instructors
& GuyJordan (P)

Class To Be Announced To Be Announced To Be Announced 01/05/2026 01/17/2026 Lecture 2 Jennifer Robbins
2 Kayla Stout-Harmon

Enrollment Counts v
Maximum Actual Remaining

Enrollment 35 12 23

Cross List 0 0 0

Results found: 2 Page D of 1 PerPage | 100 ¥

Office Hours v

From Date To Date From Time To Time Days Contact Number Location

You have no office hours added yet.

Results found: 0 Page EI of 0 PerPage 100
Add Office Hours

This will detail the Course information, Schedule Meeting Times, Enroliment Counts,
and Office Hours.

To add Office Hours, click Add Office Hours. Then click Add new Row.

ice Hours o
(® Add new Row

Then change the data to what is needed.

Office Hours v

Days

Mon Tue Wed Thu Fri Sat Sun Contact Number Location Display Delete

From Date To Date From Time To Time

(@] [wrddryyy (@] | s [©) mm © Select
Results found: 1 Page of 1 PerPage | 100 ¥

These can be copied to all CRN'’s you are activated to teach by clicking “Select Copy
to.” Click Submit



Select Copy to

Winter 2026 ART AND POWER (12750)
Winter 2026 INTRODUCTION LITERATURE
(13124)

Select Copy to ¢

You may also maintain your Office Hours by clicking “Maintain.”

Office Hours v

[studentPages.officeHours.officeHours.grid.header.fromDate] [studentPages.officeHours.officeHours.grid.header.toDate] [studentPages.officeHours.officeHours.grid.header.fromTime] [studentPages.officeHours.offic

01/05/2026 01/30/2026 07:00 16:30

paginaton recordfound: paghatinsagabl | 1| pagntionsagetabl pagiaton perpagelabe

This allows you to change the data input and add additional information.

Office Hours v

Days

From Date To Date From Time To Time Mon Tue Wed Thu Fri Sat Sun

Contact Number Location Display Delete

p1/0sr2026 [®] 1302026 [m) | o700 [©) 16:30 O Cell Phone 270-99951... + JRH 301

Results found: 1 Page ‘:I of 1 Per Page

@ Add new Row

Select Copy to .



By clicking on the link for the Course, you will see the information that is in the catalog
concerning the course

Faculty and Advisors « Faculty Detail Schedule

Faculty Detail Schedule

Term CRN

Spring 2026 - 202610 \ EDLD 799 001 DISSERTATION RESEARCH 40087 (9) s

@ Use this page to view your detailed schedule.

Course : EDLD 799 001 DISSERTATION RESEARCH 40087

Associated Term CRN Status Available for registration
Spring 2026 40087 Restricted 10/20/2025 - 01/27/2026
College Department Part of Term Credits
Education & Behavioral Leadership & Profess, School 1 1
Science
Campus Override Roster Course Level
Bowling Green No Classlist Doctoral, Graduate,
Undergraduate
Course Details for EDLD 799, DISSERTATION RESEARCH X

Term: 202610

Catalog Title: DISSERTATION RESEARCH

College: Education & Behavioral Science ED
Course Description Division:

Department: Leadership & Profess, School SLPS
Attributes Hours:

Credit Hours: 1 TO 8
Restrictions Lecture:

Lab:
Corequisites Other:
Levels:
Prerequisites Doctoral DR
Graduate GR
Fees Undergraduate UG
Grading Modes:
Pass/Fail P
Schedule Types:
Research R

You will see the Catalog description, Course Description, Attributes, Restrictions,
Corequisites, Prerequisites, and Fees that are associated with the course.



Returning to Faculty Services

To return to the Faculty Services main menu, click on the H at the top left corner. Click
Banner. Click Faculty Services. Click on any item to go to the next section. Click CRN
Selection to return to TopNet Faculty Services tab inside TopNet.

n BIWKU

<{ Banner

Student Services

I

Financial Aid

Faculty Services

Advisors & Student Data Inquiry
Employee Services

Financial Services

WebTailor Administration

vvvvva/

Personal Information

Faculty/Staff Purchasing Big Red Dollars
Faculty/Staff Purchasing Dining Dollars
Faculty/Staff Meal Plan Registration
Miscellaneous Admin Menu >
WKU On Demand/FAM Term Schedule Update
Study Abroad Maintenance Form

Study Abroad Add Form

NSE Administration Form

Topper Orientation Program (TOP) Students >

TOP Maintenance Form



Faculty Schedule by Day and Time

Display of courses and there meeting day(s) and times.

Faculty and Advisor Faculty Week at a Glance

Faculty Week at a Glance

Today - 01/12/2026

< Week 01/12/2026 to 01/18/2026 >

© No courses with assigned times this week

Courses without assigned meeting times:

ENG 290 - 850 13160 TBA
ART 317 - 700 12750 TBA

D Time O Venue

Return to the Faculty Services main menu by following the Returning to Faculty

Services instructions on page 10.

Class List

Displays information about the class and the student enrolled in the class.
e The headers change. You can change the Subject, Course Title, CRN,
Enroliment Count, Status, Duration, and Term flow based on your needs.
e As of January 2026, CRN's starting with a 0 will not allow you to click on the
Subject to see the Summary Class List. Please continue using Detail Class List

or Summary Class List for those CRN’s.

Faculty & Advisors « CRN Listing
CRN Listing

All Terms v

Select Course

Course Title C CRN

Subject <
ART 317,700 ART AND POWER 12750

ENG 200, 702 INTRODUCTION LITERATURE 13124

Click on the Subject.

Enroliment Count

12

26

Status

Open

Open

Duration

01/05/2026 - 01/17/2026

12/15/2025 - 01/03/2026

¥ | Search (Ctrl+Cmd+Y)

Term

Winter 2026 (202605)

Winter 2026 (202605)

e This will give you the Course Information, Enroliment Counts, as well as a
Summary Class List, with Student Information and pictures.

11
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Faculty & Advisors « CRN Listing « Class List

Class List [5> Export ;,J Print

Winter 2026 - 202605  ART 317 | 12750 Vv

¥ Course Information Enroliment Counts
ART AND POWER - ART 317 700 Maximum  Actual Remaining
CRN: 12750 Enrollment 35 12 23
Duration: 01/05/2026 - 01/17/2026 Wait List 0 0 0
Status: Open Cross List 0 0 0
Class List Summary View v
Summary Class List ~ | search (Ctrl+Cmd+Y) Q
Student Name ~ D C  Registration Status T Level C  Credit Hours C  Final T Class <
Registered (Web) Undergraduate 3 8 Senior
Registered (Web) Undergraduate 3 Enter Grade Senior
Registered (Web) Undergraduate 3 Enter Grade Senior
Registered (Web) Undergraduate 3 Enter Grade Senior
Re-Registered (Web) Undergraduate 3 Enter Grade Senior

Please note, this will show any student who has requested their information remain
confidential with a yellow banner under the name.

‘ w _ Registered (Web) Graduate 1 No Access Doctoral Program

By clicking the Export in the top right, you can export your list to Excel.

e Please note, includes all information under the Summary Class List as well the
enrollment, wait list, and cross list information. You will have your Course
Information on the spreadsheet.

Click the Export Template preference for Excel.

e Excel xIs is the pre-2007 version of Excel.

e Excel xlIsx is the Excel 2007+ version.

Export Template Cancel

Export files as

© Excel Spreadsheet - .xIs
Excel Spreadsheet - .xIsx

e Watch for the download in your browser.
e w [&

Recent Download History X

Close

m 202610_40087_classlist (* & 3
6.5 KB - 4 minutes ago
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Please note, any individual that was marked confidential in the Summary Class List will
show up on the spreadsheet with [CONF} by the name.

4| A 8 c D € F G H

Course Information 5

Course Title DISSERTATION RESEARCH - EDLD 799 001
Term Spring 2026 - 202610

CRN %0087

Duration 01/20/2026 - 05/07/2026

Status Restricted

Enroliment Counts

Maximum Actual Remaining
Enroliment 20 ] "1
Wait List ] ]
Cross List ] ] ]

Summary Class List
Student Name 1D Registration Status Level Credit Hours Midterm Final Class
[CONF Registered (Web) Graduate 1 No Access No Access Doctoral Program

Registered (Web) Graduate 1 No Access No Access Doctoral Program
Registered (Web) Graduate 1 No Access No Access Doctoral Program
Registered (Web) Graduate 1 No Access No Access Doctoral Program
Ragistered (Web) Graduate 1 No Access No Access Doctoral Program
Ragistered (Web) Graduate 1 No Access No Access Doctoral Program
Ragistered (Web) Graduate 1 No Access No Access Doctoral Program
Ragistered (Web) Graduate 1 No Access No Access Doctoral Program
Registered (Web) Graduate 1 No Access No Access Doctoral Program

To email, click on the box by the individual student or the box in the heading to select
all, and click the email icon.

**Please make sure pop-up blocker is turned off.

Faculty & Advisors « CRN Listing « Class List
Class List [ Export (&) Print

Winter 2026 - 202605  ART 317 | 12750 Vv

¥ Course Information Enroliment Counts
ART AND POWER - ART 317 700 Maximum Actual Remaining
CRN: 12750 Enrollment 35 12 23
Duration: 01/05/2026 - 01/17/2026 Wait List 0 0 0
Status: Open Cross List 0 0 0
Class List Summary View v
Summary Class List — : ~ | Search (Ctrl+Cmd+Y) Q
Student Name ~ D T Registration Status C  Level C  Credit Hours ¢ Final Class t
Registered (Web) Undergraduate 3 B Senior
Registered (Web) Undergraduate 3 Enter Grade Senior
Registered (Web) Undergraduate 3 Enter Grade Senior
Registered (Web) Undergraduate 3 Enter Grade Senior
Re-Registered (Web) Undergraduate 3 Enter Grade Senior

This will bring up your email box from your default email app.
**If your mail is defaulted to another inbox other than the Microsoft app for your WKU

email, please contact the Service Desk at 270-745-7000 for assistance in changing that
default.
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Return to the Faculty Services main menu by following the Returning to Faculty
Services instructions on page 10.

Summary Class List with Drops

This is a list of all students, active and inactive, that enrolled in your course(s).
¢ Rows that show in “blue” are the students who have been dropped from the
course or withdrawn from course. Check the status under the Reg heading.

This will give you a list of the WKU ID’s, Student Name, Preferred Name, Pic (click
view), Student Email, Level, Degree, Program, Major, Class, Credit Hour, Registration,
and 5" Week Check in.

**Please note, as of January 2026, this option is still available but subject to change.
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Summary Class List With Drops : Winter 2026

Student Name |[Preferred Name][ Pic Student Email [Level|Degree]| Program I Major | Class__|[crHr][Reg][5th WK
G |BS* |Finance-BS* [[Finance * [[senior [3.00fRW] 0 ]
G _|BS | Mechanical Engineering-BS _|[Mechanical Engineering-Prep _|[Freshman | 0.00]DW[[ 0
G_|BIS _|[interdisciplinary Studies-BI ciplinary Studi [Senior [3.00[RW] 0
G Health Care Adm-BS Health Care Admin- Seeking Admi|Junior 3.00HRW 0
G [Film Production-BFA Film Production * [Senior 300[RW][_0
G Science-BS-747 | jcal Science Junior 3.00[RW][ 0
G [Nursing-BSN [Nursing (Pre-Nursing) [Sophomore ] 0.00[pW][_ 0
G_|BS _|[Health Care Adm-BS Health Care Admin- Seeking Admi|Junior W‘M L 0 |
G _|BS__ |Biology-BS-617 [Biology Sophomore_|[3.00[RE || 0|
G_|[BSW_|[Social Work-BSW [Social Work-Prep 0.00pw][_ 0

IAccounting-BS IAccounting * Junior 3.05\ Ew 0
5 [interior Design Fashion Stu-BS [interior Design & Fashion Stdy |[Sophomore _[0.00[DW][_ 0]
[Marketing-BS [Marketing Senior [0.00jow] 0 |
[Business Data Analytics-BS _|[Business Data Analytics Sophomore __J[0.00[DW][ 0 ]
[Exercise Science-BS [Exercise Science [0.00fow][ 0|
BS [Chemistry-BS [Chemistry ophomore 3.U@EW
ND {Academy (Math & Science)-ND||Academy (Math & Science) |Academy Juniol 3.U§\BW 0
BS i istry-BS Biochemistry Senior 3‘00\§W 0

You may Download to Excel by clicking the icon at the bottom of the page.

| Download to Excel |

Rece!

Lis |

Watch for the download in your browser.

W % @

nt Download History X

202605-13124-class-listx ™ [}
19.8 KB « 1 minute ago

Final Grades

This will show you the courses you are assigned and the Grading Status of each

course.
e You many need to double click on the heading to change the data flow.
e You will click on Grading Status, Rolled, Subject, etc. to get to the screen to enter
grades.
e You can search by Term to find the most recent courses. Terms are by year and
code. (05-Winter, 10- Spring, 20-Summer, 30- Fall. Ex. Spring 2026 is 20610)

Faculty Grade Entry

s Course o Section s Tide 2 Term s RN
310 001 MANAG COST ACCOUNTING 00053
310 001 MANAG COST ACCOUNTING 00053
300 001 INTERMEDIATE FINANCIAL ACCTG w292
10 001 ACCT FOR DECISION MAKERS 202610 - Spring 2026 anss
220 002 PRIN FINANCIAL ACCT 202610- Spring 2026 anas
300 001 INTERMEDIATE FINANCIAL ACCTG 48240
10 001 ACCT FOR DECISION MAKERS 50389
20 002 PRIN FINANCIAL ACCT 202530.-Fall 51096

15



Once you have your courses sorted, you will have the option to input your grades or
import the grades.

Faculty Grade Entry - Final Grades

Faculty Grade Entry

Final Grades
My Courses 202610 q
Grading Status 2 Rolled 2 Subject s Course 2 section s Title s Term s RN
Not Started ACCT - Accounting (Univ) 310 001 MANAG COST ACCOUNTING 202610 - Spring 2026 00053
Not Started ACCT - Accounting (Univ) 300 001 INTERMEDIATE FINANCIAL ACCTG | 202610 - Spring 2026 42792
Not Started ACCT - Accounting (Univ) 110 001 ACCT FOR DECISION MAKERS 202610 - Spring 2026 47135
Not Started Not Started ACCT - Accounting (Univ) 220 002 PRIN FINANCIAL ACCT 202610 - Spring 2026 47144

Click on the course to enter grades. You will be shown all the courses needing Final
Grades at the top, and the section your selected to enter grades.

Faculty Grade Entry

Final Grades
My Courses <
Grading Status 2 Rolled £ Subject s Course 2 Section o Title 2 Term 2 CRN
Not Started ACCT - Accounting (Univ) 431 001 FEDERAL INCOME TAXATION Il 202610 - Spring 2026 00071
Not Started ART - Art 131 001 THREE DIMENSIONAL DESIGN 202610 - Spring 2026 00397
In Progress Not Started ART - Art 317 700 ART AND POWER 202605 - Winter 2026 12750
Completed Completed ENG - English 200 702 INTRODUCTION LITERATURE 202605 - Winter 2026 13124

Full Name s D £ Final Grade < Rolled £ LastAttend Date

I

To change the grade, click on the box under Final Grade and make your selection. You
can also add the Last Attend Date if needed.

Click Save to save the data input.
You may also use the Search Bar to search for a specific student.

The Rolled section will let you know if the grades have been transferred to history (the
students transcript). A Completed status means the grades have been transferred. In-
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Progress is waiting to be transferred. Not Started means the grades have not been
entered or the process has not started.
e You may adjust the grades if the grades have not been rolled.
e |f grades have been rolled, you will need to contact the Registrar’s Office for a
Change of Grade.

Faculty Grade Entry - Final Grades

Faculty Grade Entry

Final Grades
My Courses (@ | [202610
Grading Status 2 Rolled £ Subject s Course £ Section s Title s Term s RN
Not Started Not Started ACCT - Accounting (Univ) 310 001 MANAG COST ACCOUNTING 202610 - Spring 2026 00053
Not Started Not Started ACCT - Accounting (Univ) 300 001 INTERMEDIATE FINANCIAL ACCTG | 202610 - Spring 2026 42792
Completed Not Started ACCT - Accounting (Univ) 110 001 ACCT FOR DECISION MAKERS 202610 - Spring 2026 47135
Not Started Not Started AACCT - Accounting (Univ) 220 002 PRIN FINANCIAL ACCT 202610 - Spring 2026 47144
Records Found: 4 rage (1 ]on1 recrase (10

To Import your grades from an Excel sheet, you must have Term, CRN, Student ID
number, and Grade. You would click on the course to import the grade. Click the %

Scroll to Import.

Keyboard shortcuts
Extensibility

Edit Extensions

Upload Properties

Theme Editor v

Export Template

I Import I

Select your File to Upload. Click Continue. (This is shaded.)

o Select () Preview () Map Q Validate Cj Finish

Select a File for Import

T T T T T .
Browse Upload
= S = = i (xlsx)

17




Check if your Spreadsheet has headers. Click Continue. (This is shaded out.)

Import

@ Select o Preview () Map () Validate () Finish

Preview File

Check the box if your spreadsheet includes headers. Use the grid to preview the data prior to

importing.

Row Name

ID

Term CRN Grade

My Spreadsheet has headers.

1

202610 00053 A

202610 00053 C

Go Back

You will need to map how the data is pulled from the spreadsheet by the information
available. Change “Other” to the appropriate fields. Click Continue. (This is shaded out.)

Import

@ st | @) proview | @ Map ! () Ve | (3) Fnich

Map Columns

Use the drop down lists to map the data from your spreadsheet to the appropriate columns on the
Faculty Attendance Page.

Fields marked with * are required fields. They must be mapped in order to continue the import
process.

Student ID*

Final Grac

sion Date e
Map (other [ other ~other DE ~other v) I
Row Name 1D Term CRN Grade

1 202610 00053 A

2 202610 00053 C

Go Back

18

Import

@ seeat @) prview | @ Map | (3) vatdae | (3) Fiish

Map Columns

Use the drop down lists to map the data from your spreadsheet to the appropriate columns on the
Faculty Attendance Page.

Fields marked with * are required fields. They must be mapped in order to continue the import
process.

e on Date Nar omment
Map (other Pstugencioe _Jrerm coder - Tcans - [Final Grade ]
Row Name 1D Term CRN Grade
1 202610 00053 A
2 202610 00053 (&

Go Back




The form will Validate and let you know how many records will be imported. Click
Continue. (This is shaded out.)

Import
O Select (D Preview O Map ° Validate (j Finish

Validate

Validate the data in the worksheet. Unchanged data will be ignored; valid changes will overwrite
existing data after this step.

The following 2 records will be imported:
0 records containing errors will not be imported.
0 unchanged records will not be imported.

Download the validation report

Row Name ID Term CRN Grade
1 202610 00053 A
2 202610 00053 C

Imiort will Comilete. Click Finish. iThis will be shaded out.)

@ Select (J\ Preview O Map @ Validate ° Finish
Import Complete
The import wizard is complete.

2 Records without error have been imported and saved to the database.

Records with errors can be corrected on the validation report and imported again using this wizard
or updated manually using the application.

e Please note, this will return you to the screen with all your courses. You will need
to search by Term.



Click on the course and you will see the Grades uploaded.

Faculty Grade Entry - Final Grades

Faculty Grade Entry

Final Grades
My Courses 202610 4
Grading Status 2 Rolled s Subject s Course o Section s Title s Term s CRN ~
I In Progress Not Started ACCT - Accounting (Univ) 310 001 MANAG COST ACCOUNTING 202610 - Spring 2026 00053
Not Started Not Started ACCT - Accounting (Univ) 300 001 INTERMEDIATE FINANCIAL ACCTG | 202610 - Spring 2026 42792
Completed Not Started ACCT - Accounting (Univ) 10 001 /ACCT FOR DECISION MAKERS 202610 - Spring 2026 47135
Not Started Not Started ACCT - Accounting (Univ) 220 002 PRIN FINANCIAL ACCT 202610 - Spring 2026 47144

Records Found: 4

Enter Grades

Full Name z D 2 || Final Grade 2 Rolled £ LastAttend Date

@ [@ @ @

To print a copy of your course grades, click on the course. At the top, click the ﬂ

Faculty Grade Entry - Final Grades

Faculty Grade Entry

Final Grades
My Courses 202610 q
Grading Status 2 Rolled s Subject s Course o Section s Title s Term s GRN ~
Not Started Not Started /ACCT - Accounting (Univ) 310 001 MANAG COST ACCOUNTING 202610 - Spring 2026 00053
Not Started Not Started /ACCT - Accounting (Univ) 300 001 INTERMEDIATE FINANCIAL ACCTG | 202610 - Spring 2026 42792
Completed Not Started /ACCT - Accounting (Univ) 110 001 AACCT FOR DECISION MAKERS 202610 - Spring 2026 47135
Not Started Not Started /ACCT - Accounting (Univ) 220 002 PRIN FINANCIAL ACCT 202610 - Spring 2026 47144
Records Found: 4 age (1] o
Enter Grades
Full Name ) 2 Final Grade 2 Rolled 2 LastAttend Date $

Scroll down to Export Template.
|
About
Keyboard shortcuts

Extensibility
Edit Extensions
Upload Properties v

Theme Editor

Export Template
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Select your Excel format. Click the Export. (This is shaded.)

Export Template
ance

Export files as
(® Excel spreadsheet(.xls)

Excel spreadsheet(.xIsx)

Your download will pop up in your downloads on the browser.

Recent Download History

m 202610_Accounting ()

(Univ)_310_001_Template.xis
8.0 KB -« Done

Full Download History

AutoSave @ h B B [ ) 202610_Accounting (Univ)_110_001_Template.xls - Compatibility Mode

Insert Draw Page Layout Formulas Data Review View Automate

== _ b, wrap Text v General [ gy E{/E‘v @/jv Ev Ev @v

& T © v 9 Conditional Format  Cell Insert  Delete  Format
&= Merg $ % 9 Formatting as Table Styles

Student ID

13
2

Confidential Course Final Grade
Accounting (Univ)
Accounting (Univ)
Accounting (Univ)
Accounting (Univ)
Accounting (Univ)
Accounting (Univ)
Accounting (Univ)
Accounting (Univ)
Accounting (Univ)
Accounting (Univ)
Accounting (Univ)
Accounting (Univ)
Accounting (Univ)
Accounting (Univ)
Accounting (Univ)
Accounting (Univ)
Accounting (Univ)
Accounting (Univ)
Accounting (Univ)
Accounting (Univ)
Accounting (Univ)
Accounting (Univ)
Accounting (Univ)
Accounting (Univ)
Accounting (Univ)
Accounting (Univ)
Accounting (Univ)
Accounting (Univ)
Accounting (Univ)
Accounting (Univ)
Accounting (Univ)
Accounting (Univ)
Accounting (Univ)
Accounting (Univ)

§58858588888858585888588885588¢5858888¢8%832

§558558588888858588¢8858888588¢88588¢%¢¢%
GEP>>PPP>>P>00> P00 NONNEIOIE NP OO D >

%7135

Return to the Faculty Services main menu by following the Returning to Faculty
Services instructions on page 10.
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Change of Grade Worksheet

This option is available after grades have rolled. If you need to change a grade prior to
the roll, please change the grade in the Final Grade section.

@ & hitps://acsappswhu.edu/pls/test/wku_grade_change © ~ @ B © | (41 Change of Grade Worksheet l _’GD *
TEST ENVIRONMENT

Search SITEMAP HELP EXIT

Student Services  Financial Aid Faculty Services Advisors & Student Data Inquiry Employee Services Personal Information  Finance Self-Service

Change of Grade Worksheet

* Search by Term
* Search by Student

Select a term from the change of grade term box and click continue.
Select a CRN from the CRN box and click Submit.

Change of Grade Worksheet : Spring 2013
\é) - This online grade change process is to be used only for assigning final grades to replace X, IP, NR or ER
- Ifthe original grade was an IP or X, the date of completion is required
- If submitting an FN grade, the last attendance date is required
- Enter the change of grade(s), and then click Submit Grades
34462 COMN 161C 826 BUS & PROFESSIONAL SPEAKING
WKU ID Name Credit Hours Current Grade Grade Change Last Attend Date  Date Completed
For FN Grade (MM/DD/YYYY)
(MM/DDIYYYY)
3 P None ~ | [
3 1P None ~ | [
3 1P None ~ | [
3 1P None ~ | [
3 1P None ~ | [
3 1P None ~ | [
3 1P None ~ | [
3 1P None ~ | [
3 1P None ~ | [
3 P None ~ | [
3 1P None ~ | [
3 1P None ~ | [
3 1P None ~ | [
3 1P None ~ | [
3 1P None ~ | [
3 1P None ~ | [
3 1P None ~ | [
3 P None ~ | [
3 1P None ~ | [
3 P None ~ | [
3 1P None ~ | [
3 1P None ~ | [
3 P None ~ | [

=
Grade Change Term | Change CRN
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Select a grade from the drop-down box and enter a date if required.
Click on the “Submit Grades” button to complete your transaction.

Change of Grade Worksheet : Fall 2012

‘\}:/ - This online grade change process is to be used only for assigning final grades to replace X, IP, NR or ER
- If the original grade was an IP or X, the date of completion is required
- If submitting an FN grade, the last attendance date is required
- Enter the change of grade(s), and then click Submit Grades

35959 PSY 100 822 INTRO PSY

WKU ID Name Credit Hours Current Grade Grade Change Last Attend Date Date Completed
For FN Grade (MM/DD/YYYY)
(MM/DD/YYYY)
3 P A~ [01715/2013
3 P B~ | [01718/2013
3 P None |~ ‘ | I
3 P | I
A
3 P B | |
C
3 P D | |
3 P F | |
FN
X
Grade Change Term | Change CRN

Registration Overrides

Faculty members will be able to perform Registration Overrides based on the
department’s policy. Select the Registration Overrides link. (Authority to process
registration overrides will be determined by your academic department head. Some
departments prefer that all overrides be handled centrally, while other departments will
permit faculty to override course limits and to allow students into restricted courses they
teach.)

Select the Term and input the Student/Advisee ID or search by Last Name, First Name.

Student and Advisee ID Selection

@ Enter the ID of the Student or Advisee you want to process or enter partial names,student search type or a combination of both. Then select Submit
Term
Select
O\ Last Name First Name
-
Winter 2026 - 202605
Search Type Students Advisee © Both
Fall 2025 - 202530
Summer 2025 - 202520
Spring 2025 - 202510
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When you click submit, the student information will show under the Student and Advisee
Selection. Click on the Student.

Student and Advisee Selection

1D S Name < Type

Faculty members will only have the ability to enter overrides on their courses.

Select the correct Override from drop down menu. Select the correct course from the
Course drop down menu.

Registration Overrides

Override Course

Select elect \ (+) Add id
‘ () Add Override

Capacity Override

Classification Override

Co-req Override

College Restriction Override

3

Registration Overrides

Override Course

Capacity Override \ ‘ Select ‘
| Q

13160-ENG 290 850

€ Back to ID Selection
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The screen will also include the information on the student, as well as the course
information.

Current Student Schedule

Total Credit hours: 3
INTRODUCTION LITERATURE - ENG - 200 - 702

Associated Term CRN

Status Credits
Winter 2026 13124 Registered (Web) on 12/01/2025 3
Course Level Campus Grade Mode Instructor(s)
Undergraduate Web Standard Letter & Brenna Sherrill

& Jennifer Robbins
B Kayla Stout-Harmon

Scheduled Meeting Times

Type C  From Time C  ToTime Days Where ¢ start Date ¢ EndDate C  ScheduleType ¢ Instructors
& Brenna Sherrill (P)
Web Course
Web Delivery To Be Announced To Be Announced Delivery 12/15/2025 01/03/2026 Lecture B Jennifer Robbins

£ Kayla Stout-Harmon

® There are no current overrides for the selected student and term

Click submit for the Override.

Registration Overrides

Override Course

Capacity Override N 13160-ENG 290 850 N ’ @ Add Override

< Back to ID Selection

You will receive a “Save Successful” message when complete and the Current Student
Overrides will be displayed.

& Save Successful
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Current Student Overrides

Override C  Course £ Activity Date ¢ Entered by

Capacity Override 13160 - ENG 01/12/2026 U_ROBBINS|G

Results found: 1 Page l:‘ of 1 Per Page ‘ 1000 "

Return to the Faculty Services main menu by following the Returning to Faculty
Services instructions on page 10.

Office Hours

This will allow you to set Office Hours for your classes.

Select your Term and CRN:

Faculty and Advisors Office Hours

Office Hours
Term CRN
Spring 2026 - 202610 N /ACCT 110 007 ACCT FOR DECISION MAKERS 47141 (35) 4
B Spring 2026 - 202610 /ACCT 110 007 ACCT FOR DECISION MAKERS 47141 (35)
for a class.  gp; 799 001 DISSERTATION RESEARCH 40087 (9) n adding office hours. Students may view your office hours when the Display indicator is checked.
Winter 2026 - 202605

Fall 2025 - 202530
Summer 2025 - 202520

Spring 2025 - 202510

You will see your Course Information, Scheduled Meeting Times and set your Office
Hours.

To add Office Hours, click Add new Row.

0N
\+/) Add new Row

Then change the data to what is needed.
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Office Hours v

Days

Contact Number Location Displa Delete
Mon Tue Wed Thu Fri Sat Sun play

From Date To Date From Time To Time

m]  [Mwddyyy @ | rsmm © | HHmm ) select * Locatior

Results found: 1 Page of 1 PerPage | 100 ¥

e Click the Clock to scroll to the time needed.

e PM time is in Military Time (ex. 1:00pm is 13:00)
Your contract information will pull all information available. Please pay attention
to what phone number is chosen.

These can be copied to all CRN’s you are activated to teach by clicking “Select Copy
to.” Click Submit

Select Copy to

Winter 2026 ART AND POWER (12750)
Winter 2026 INTRODUCTION LITERATURE
(13124)

Select Copy to ¢
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Course Syllabi Maintenance

Course List winter 2026

Selected Term

Winter 2026 s

<4

Search 25 4 perpage Export v Columns

Course ! ! It Instructor ! Syllabus URL It Actions
Search Course Search CRN Search Title Search Instructor Search Syllabus URL

WFA 444 - 700 13421 Hammonds, Jennifer Raye 5
THEA 499 - 880 13441 IND ST/BRITISH THEATRE Hatton, Michael S TS TR e e B @
THEA 341 - 881 13439 CULTURE AND PERFORMANCE Jordan, Carol https://app.wku.edu/syllabus/get?file=THEA341881_: ﬁ @
THEA 151 - 881 13438 THEATRE APPRECIATION Jordan, Carol https://app.wku.edu/syllabus/get2file=THEAT 51881 ; B ®
TCHL 530-700 13398 CURRICULUM DEVELOPMENT Margarella, Erin Elizabeth ﬁ

SWRK 673 - 700 13343 GRIEF/LOSS ISSUES INTERVENTION Mallinger, Gayle Marcus

L]
®

https://app.wku.edu/syllabus/get?file=SWRK673700_

Select by Term and Search by Course, CRN, Title, etc.

Click on the 4] to upload the syllabi.

28



“Choose a file” and select your syllabi to upload.

Upload Syllabus

= 2} WFA 444 - 700 ) winter 2026

B syllabus PDF

B Choose  file _

in . pdf format.

@) Recents 3 M TopNet
9 shared

M Banner Ellucian Guides B AA-Advisors...uiry Tab.pdf
Eavorites M Banner Finance B AC-Advisors...uiry Tab.pdf
M Banner How To B AL-Advisors...quiry Tab.pdf
M Banner Student B AU-Advisors...uiry Tab.pdf
(&) Desktop ™ BDMS n
[ Documents W FERPA i
M FLAC B Proxy Access.pdf
M InfoView i
M Request Info B Registration Overrides.pdf
™ TopNet

A\ Applications

@ Downloads

Locations

iCloud Drive
S B topnet7-faculty.pdf

¢2) OneDrive 1 P
B TOPNETSTAFF2024.pdf Information

=) ~

Q jenniferrob...

Macintosh...

@ Network Show Options

Click Open. Click Submit.

You will receive a Syllabus Uploaded message when successfully uploaded.

v Syllabus Uploaded! x
The syllabus for WFA 444 - 700 was successfully uploaded to https://app-test.wku.edu/syllabus/get?file=WFA444700 202605 13421.pdf

View Syllabus
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Click on the @ to view the uploaded syllabi.

cc076a_a872¢3ad615241aa840922bddf73b20d. pdf

Syllabus

Course Title: British Theatre & Entertainment: From Shakespeare to the
Mega-Musical

Program and Date: London Winter - 2025/26
Academic Department: Theatre & Dance
Instructor Name: Michael W. Hatton

Instructor Email and Phone: hattonm@nku.edu; 859-572-6160

Get to Know Your Professor

Mr. Hatton is a professor of Theatre at Northern Kentucky University and specializes in theatre
history, dramatic literature, theory, and criticism. He started travelling internationally at the age
of 14 and hasn't stopped since. Through his many travels, Mr. Hatton developed a love for culture,
history, and the human experience across our amazing planet. He has taught for CCSA as well as
served as a Program Director on many of their programs over the years. Mr. Hatton has a
fondness for visiting London street markets, mudlarking in the Thames, and enjoying the many
rooftop gardens scattered across the city. He is the proud dad of a dog named Amber, who doesn't
enjoy traveling nearly as much as her dad.

Course Description

Explore the best of British Theatre and Entertainment! The city of London serves as the backdrop
for your adventures as British history comes alive before your eyes. Experience a diverse range of
professional theatre and entertainment, from classics to new works, Shakespeare to mega-
musicals, pub theatre to dance, all of which reflect cultural trends and social issues viewed
through the lens of British theatre. The influence of British history will be experienced firsthand
as students visit theatres, museums, historic sites (e.g, Stratford-upon-Avon, the National
Theatre, the Globe Theatre, Westminster Abbey, and more), participate in hands-on experiences,
and attend notable and dynamic theatre productions. Group discussions will be a vital part of
class time in London, and guests from the field will visit the class on location.

If you need to delete a syllabus, please highlight the link beside your course, and click
delete (on your keyboard).

Course List spring 2026

Selected Term

Spring 2026 =
Search 25 & | perpage

Export v Columns v

Course

Instructor Syllabus URL Actions It
Search Course Search CRN Search Title Search Instructor Search Syllabus URL
WFA 4. 44955 WORKFORCE PROCESS & TECH Kontos, George

syllabus/get?file=WFA44770) | L+ JKOJ

Click the Save icon, or click enter, to update.

You will receive a notice that you have saved the URL and removed the syllabi.

v

Syllabus URL Saved
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**Please let any professors know if you have mistakenly uploaded/deleted a syllabi
connected to their course. Follow the steps in Schedule of Classes and “Lookup Any
Class Roster” to fine the professor.

Follow the steps to add a new syllabus.

Drop for Non-Attendance Worksheet

Select the CRN needed for the report.

mwa--

| Search RETURN TOMENU SITE MAP HELP EXIT |

Student Services  Financial Aid Faculty Services ~Advisors & Student Data Inquiry Employee Services Personal Information  Finance Self-Service

Select a CRN for Sumae 2018

May 28, 2015 01:46 pm

&R Please select the CRN you wish to access, o select a different term from the menu.

CRN: SLP AND COUNSELING - 38038 v

Check with the Registrar’s office to review this policy.

® Fail to attend the first two class meetings of a course meeting multiple times per
week or the first meeting of a class that meets one time per week.

® \Web-based course shall be defined as failure to perform meaningful
academically related activity (including, but not limited to, the following:
submitting an academic assignment, taking an exam, participating in an online
discussion about academic matters) within one week of the course start date
without previous arrangements with the instructor or department.

For those students that need to be dropped find their name on the roster and select the
drop-down menu and select “Drop for Non-Attendance”.
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Faculty Drop for Non-Attendance : Winter 2026

From this worksheet you may drop students for Non-Attendance. You cannot re-register dropped students from this page.
You must contact the Office of the Registrar @745-3352 or 745-5028 to correct errors.

13394 BIOL 120 701 BIOL CONC CELLS METAB GENETICS

Welcome to Faculty Drop for Non-Attendance Worksheet on Jan 13, 2026 at 08:30 AM

b Caution -- You MUST click "Submit Drops" button at bottom of page to SAVE changes! ! |

Rec#|Reg. Seq)| StudentName |[Credits|  Reg.Status/iDate  |[Grade||  Attendance Action __|[Probability Not at WKU|
1 1 ) 3.00”Re-Registered (Web) / Dec 09, 2025] None o
2 16 | 3.00”Registered (Web) / Dec 17, 2025 None >
3 6 | 3,00"Re-Registered (Web) / Dec 16, 2025 | None S
4 17 | 3_00”Registered (Web)/ Dec 17, 2025 None . ]
5 13 | 3_00”Registered (Web) / Dec 13, 2025 None >
6 14 | 3.00”Re-Registered (Web) / Dec 17, 2025] None >
7 4 | 3.00”Re-Registered (Web) / Dec 10, 2025” None o

b Caution -- You MUST click "Submit Drops" button at bottom of page to SAVE changes! ! |

Faculty Drop for Non-Attendance : Winter 2026

From this worksheet you may drop students for Non-Attendance. You cannot re-register dropped students from this page.
You must contact the Office of the Registrar @745-3352 or 745-5028 to correct errors.

13394 BIOL 120 701 BIOL CONC CELLS METAB GENETICS

Welcome to Faculty Drop for Non-Attendance Worksheet on Jan 13, 2026 at 08:30 AM

y Caution -- You MUST click "Submit Drops" button at bottom of page to SAVE changes! ! |

Rec.#|Reg. Seq| StudentName |[Credits|  Reg. Status/Date Grade]|_

1 1 | 3_00||Re-Regislered (Web) / Dec 09, 2025 '
2 16 | | 3,00“Registered (Web) / Dec 17, 2025

3 6 | | 3_00||Re-Regislered (Web) / Dec 16, 2025

4 17 | | 3,00“Registered (Web) / Dec 17, 2025

5 13 | | 3_00||Registered (Web) / Dec 13, 2025

6 14 | | 3,00“Re-Registered (Web) / Dec 17, 2025

7 4 | | 3_00”Re-Regislered (Web) / Dec 10, 2025

,‘J Caution -- You MUST click "Submit Drops" button at bottom of page to SAVE changes! ! !

After all are selected for “Drop For Non-Attendance”, click the Submit Drops.

You will be asked to confirm your drops. Click SUBMIT Pending Drops.
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Confirm Drop for Non-Attendance : Winter 2026

You have selected the following student(s) for enroliment termination in the course listed. Please review carefully before clicking the "Submit" button.
Errors must be corrected by the Office of the Registrar (745-3352 or 745-5028). You cannot reverse a "drop for non-attendance” transaction online once it has been processed from this form.

Pending Drops for: 13394 BIOL 120 701 BIOL CONC CELLS METAB GENETICS

Reg. Seq][ Student Name |[Credits]| Pending Action

[ 3.00][Drop for Non-Attendance Pending
[ SUBMIT Pending Drops | | CANCEL Pending Drops |

RELEASE: 5.0.0.1

You will see your drops listed in red with the drop date.
Faculty Drop for Non-Attendance : Winter 2026

From this worksheet you may drop students for Non-Attendance. You cannot re-register dropped students from this page.
You must contact the Office of the Registrar @745-3352 or 745-5028 to correct errors.

13394 BIOL 120 701 BIOL CONC CELLS METAB GENETICS

Welcome to Faculty Drop for Non-Attendance Worksheet on Jan 13, 2026 at 08:34 AM

y Caution -- You MUST click "Submit Drops" button at bottom of page to SAVE changes! ! |

Rec.#|Reg. Seq| StudentName _|[Credits|| Reg. Status/Date |[Grade]| Attendance Action [Probability Not at WKU|

1 1] [ 0.00][Dropped (Non-attendance) / Jan 13, 2026 |[Dropped, No Further Action Allowed
2 16 | | 3,00||Registered (Web)/ Dec 17, 2025 | None &

3 6 | | 3.00][Re-Regitered (Web)  Dec 16, 2025 |
4 17 | I 3,00“Registered (Web)/ Dec 17, 2025 |
5 13 | I 3,00“Registered (Web) / Dec 13, 2025 |
6 14 | I 3,00“R9-Regisnered (Web) / Dec 17, 2025 |
7 4 | I 3,00“R9-Regisnered (Web) / Dec 10, 2025 ”,m—\iv

y Caution -- You MUST click "Submit Drops" button at bottom of page to SAVE changes! ! |
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Course Calendar

This will show you the meeting dates of your courses. Select a Term then list appears —
select link Course Calendar.

serch[ |[Go] RETURNTOMENU SITEMAP HELP EXIT

Student Services  Financial Aid  Faculty Services Advisors & Student ploy Personal WebTallor Menu  Finance Self-Service  Misc Admin

Generate Course Calendar for: Spring 2026

Search By ONE of the following (Subject, Instructor or CRN)

wesemsees COUPSE D meeeeeee
Subject Area Course Number Section Number weeses [NStrUCEOF wemeee =CRN--
[NoNE vai ] OR-(NOE 0[]
CRN Subj Crse Sec Title Instructor

= Actions -

00071 ACCT 431 001 FEDERAL INCOME TAXATION Il Robbins, Jennifer G. Course Calendar e
00397 ART 131 001 THREE DIMENSIONAL DESIGN Robbins, Jennifer G. Course Calendar

RELEASE: SYLLABI MAINT 1.0

©2026 Ellucian Company L.P. and its affiliates.

The Generate Course Calendar page will show the days for the course.

Generate Course Calendar

00071 ACCT 431001 (FEDERAL INCOME TAXATION Il) Term: 202610|
MW (Monday From: To: 05/07/2026
Wanuary 21 Wednesday
Wanuary 26 Monday
Wanuary 28 Wednesda,
February 02 ||Monday
February 04 |Wednesda)
February 09 _[[Monday
February __“msday

February 16| [Monday
February _‘ Wednesday
February 23 |Monday

February jWednesday
[March02_[Monday

Erch 04 \ |Wednesday

Erch 09 JMonday
[March 11 Wednesday
[March 16 Monday [Spring Break Day

[March 18 [Spring Break Day

[March 23 Monday
[March 25

[March 30 [Monday
[April 01

Click the Download to Excel to get a full listing.

Download to Excel




Look for your download in your browser.

w Y&

Recent Download History

5 | 202610_00071.xls

4.5 KB - Done

The download will show the dates of your course.

| A

b B 00071 ACCT 431001 (FEDERAL INCOME TAXATION 1) Term: 202610

21-Jan
26-Jan
28-Jan
2-Feb
4-Feb
9-Feb
11-Feb
16-Feb
18-Feb
23-Feb
25-Feb
2-Mar
4-Mar
9-Mar
11-Mar
16-Mar
18-Mar
23-Mar
25-Mar

HEEEREEEEEE

MW (Monday Wednesday ) From: 01/20/2026 To: 05/07/2026

Wednesday

Monday

Wednesday

Monday

Wednesday

Monday

Wednesday

Monday

Wednesday

Monday

Wednesday

Monday

Wednesday

Monday

Wednesday

Monday Spring Break Day
Wednesday Spring Break Day
Monday

Wednesday

Monday

Wednesday

Monday

Wednesday

Monday

Wednesday

Monday

Wednesday

Monday

Wednesday

Monday Final Exam Week - Spring term
Wednesday Final Exam Week - Spring term
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Schedule of Classes and “Lookup Any Class Roster”

Select Term. Then select either Subject or other possible selection with it or Instructor.
Then click Show Me Classes button.

PN E—

Student Services  Financial Aid Faculty Services Advisors & Student Data Inquiry Employee Services Personal Information WebTailor Menu

Look-Up Classes for Term: Spring 2026

D Colonnade/General Education Courses

Instructions to Print Schedule of Classes

by End Time:

Show Only Open Courses: [

<All - Colonnade Courses ONLY>
F-W1 (College Composition)
F-W2 (Writing in the Disciplines)
F-OC (Human Communications)
F-AH (Literary Studies)

F-QR (Quantitative Reasoning)
F-SB (World History)

Finance Self-Service Misc Admin

by Subject  (Pick 5 Max) by Instructor by Course Number byOarnpus—
<al> _ Adams, Anita Ann [ ] <all>
Academy Math/Science Adams, Jonathan Daniel by Title Bowiing Green
Accounting (Univ) Adams, Richard Dennis | | (RelClol
Actuarial Science Adams-Smith, Jeanie L. ESLI (ioffice)
Adult Education Adkins, Dane Frankiin Part-of-Term by Session
Advertising _ Adler, Andrew Nicodemus <all>
Agricultural Economics Affaan Mohammed Nawaz, Fnu Schedule Type Connect
Agricultural Education Ahmed, AK M Foysal Day
Agricultural Mechanics Aikins, Jenna Foltz Evening
Agriculture - General Akins, Baylee Janell
by Start Time: Hour by Days: Mon Tues Wed Thur Fri Sat Sun By C: (general category By old General category
O 0O O 0O OO [ (Overidesallother selection criteria) <None>
<None>

<All -- Gen Ed Courses ONLY>
C-B2: Humanities - Electives
C-D1: Science

C-DL: Science Lab
C-A2: Foreign Language
C-D2: Mathematics
C-A1: English C

RETURN T(

List of courses for the Subject area selected below. Click the link ACT and you will see
a Summary Class Roster for any class in that term.

Student Services  Financial Aid Faculty Services Advisors & Student Data Inquiry Employee Services Personal Information  WebTailor Menu  Finance Self-Service Misc Admin

You Selected the following Classes: Spring 2026

"C" in first column denotes a closed course.
“NR" in the first column denotes “No Registration” - the registration period for this course has passed.
“SR" in the first column denotes “Student Restriction” - clear holds on your account that prevent registration. If no holds exist contact the Office of the Registrar.
"R"in second column denotes a restricted course. See department for course pass.
“W" in second column denotes the course has waitlisting.

- Special information about a course section will appear in a blue box beneath the course section number.

- To see prerequisite corequisite,and departmental information, click the section Title.
- Refer to Mtg Dates column for class starting and ending dates.
- To view the class roster for a specific section, click on the hyperlink in the "Act" (Actual Enroliment)

To Print the Schedule of Classes:

1. Go to File->Page Setup, click on Landscape then click OK
2. Go to View->Text and set text size to Small or Smaller

3. Go to File->Print
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|Accounting (Univ]

[JCJ[cRN |[Subj ][Crse][se [Title ampus | |Fee][Sylbi?|[Location |[Day(s)][Time | Act][Rem][instructor [Course Dates|
[a7138][AccT][ 110 ][001][3.00][ACCT FOR DECISION MAKERS i [ves | [MWF [09:10 am-10:05 am][29][ 6 |Glass, Heather __][01/20-0
[a7138][AccT][ 110 ][002][3.00][ACCT FOR DECISION MAKERS [ MWF ][12:40 pm-01:35 pm][35 ][ 0 ][Glass, Heather __|01/20-05/07 |
[47137][AccT]| 110 ][003][3.00][ACCT FOR DECISION MAKERS [MWF ][09:10 am-10:05 am][23][ 12 |[Grant, Braden [otr20-05007_]

(c|[ J47e98][accT] 110 005][3.00]ACCT FOR DECISION MAKERS [ MWF ][11:30 am-12:25 pm][35] 0 |Kile, Charles [01720-05/07

[cl][&7140][accT] 110 ][o0e][3.00][ACCT FOR DECISION MAKERS i [MWF ][10:20 am-11:15 am][24][ 0_|[Duncan, Lauren __][01/20-05/07

[c|Jla7141][accT][ 110 ][007][3.00][ACCT FOR DECISION MAKERS Bowiing Green| [cHAN'3073 | MWF ][10:20 am-11:15 am|[35][ 0 ][Grant, Braden [01720-05/07
[47142][AccT] 110 ][008][3.00][ACCT FOR DECISION MAKERS Bowling Green[$60][ N/A_|[CHAN 3075 | MWF ][08:00 am-08:55 am][ ][ 26 [Kile, Charles [o172005107
lasa3z][accT][ 110 ][010][3.00][ACCT FOR DECISION MAKERS Bowiing Green][860][ N/A |[CHAN 3074 | MWF ][11:30 am-12:25 pm][35 ][ 0 |[Duncan, Lauren | 01/20-05/07
[as712J[AcCT][ 110 ][011][3.00][ACCT FOR DECISION MAKERS [Bowling Green]560][ /A [CHAN 2002 ][ MWF ][08:00 am-08:55 am][12][ 23 |[Duncan, Lauren __][01/20-05/07
[48579[AccT] 110 |[500][3.00]|ACCT FOR DECISION MAKERS Bowiing Green][860][ N/A |[CHAN2002 || M [06:00 pm-08:45 pm][26] 8 |Jemigan, Christopher]

(c| Jja7143][AccT][ 110 ][700][3.00][ACCT FOR DECISION MAKERS wes [s60] A |wes | wkuwebcrs 433 ][Lee, Minwoo




The Class Roster will show all students enrolled, as well as their ID, Student Name,
Preferred Name, Student Email, Level, Degree, Program, Major, Class, etc.
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Summary Class Roster : Spring 2026

[CRN][Subject][Course][Section]| Title [ Stat ]| End |tatus|
[47138 AccT ][ 110 ][ 001 ][ACCT FOR DECISION MAKERS][Jan 20, 2026][May 07, 2026][ Open |

[ | Maximum][Actual|[Remaining]

[ [ 35 2] 6 ]
Rec# D Student Name [Preferred Name Student Email [Lv|Degr Program Major Class][CrHr|Reg|[Req.#[5th W]
Finance-BS Finance 50 J[300fRwls | o |

ional Affairs-AB ional Affairs * SO || 3.00[RW |2 0
Health Care Adm-BS Health Care Admin- Seeking Adm||SO || 3.00RW 24 0
ing T-BS i ineering Tech ||SO  |[ 3.00RW (23 0
|Accounting-BS |Accounting SO || 3.00|RW |22 0
English-AB English * SR || 3.00]RW||1 0
[Sport BS Sport JR | 3.00RW |26 0
ing-BS { WR | 3.00[RW |11 0
IAccounting-BS |Accounting R || 3.00]RW|[31 0
Exploratory/Undeclared-AB-180 |[Exploratory/Undeclared FR || 3.00[RW |34 0

sciplinary Studies-Bl inary Studi [JR_][3.00[RW][10

Business Economics-BS Business Economics [FR_|[3.00[Rw][27

Health Care Adm-BS Health Care Admin- Seeking Adm||SO .00[RW |5
Finance-BS Finance FR || 3.00[RW]16 0
C i BS |C FR || 3.00]RW]20 0
ing-BS Marketing FR | 3.00RE |[19 0
Business Economics-BS Business Economics JR || 3.00[RW||13 0
ing-BS FR || 3.00]RW]28 0

Scroll to the bottom of the list to Download to Excel just like you do the Summary Class
list.

Download to Excel

Check your browser for the download.
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You will have an Excel file of the students within the course.

EW AN | subject Course Section Title Stat  End  Status

2 47135 ACCT 10 1 ACCTFOR DECISIONMAKERS  20-Jan-26 7-May-26 Open

3

4 Maximum  Actual Remaining

[ enotment: s 2 6

6

7 U D Student Name LWl Degr Program Major Class CrHr Reg Req.# Sthwk
8 Riey UG BS Finance-8S Finance s0 3RW 6 0
9 Addison UG AB  International Affairs-AB = S0 3 RW 2 o
10 UG BS  Health Care Adm-8S Health Care Admin- SeekingAdm SO IRW 24 )
11 Bryant UG 8S 85 Tech SO 3RW 2 0
12 Chase UG BS  Accounting8S Accounting s0 3RW 2 o
13 UG AB  Engish-AB Engiish * s 3RW 1 )
14 UG BS  SportManagement-BS Sport Management R 3RW 26 o
15 Kody UG BS  Marketing 8BS Marketing R 3RW 11 0
16 UG BS  AccountingBS Accounting R 3 RW 31 0
17 ue A8 8 R 3RW 34 o
18 Grayson UG BIS 8IS BS) R 3RW 10 0
19 Cole UG BS B E R 3RW 27 o
20 UG BS  Health Care Adm-8S Health Care Admin- SeekingAdm SO 3RW s )
21 Samuel UG BS  Finance-8S Finance R 3RW 16 o
2 Noah UG BS  Construction Management-BS  Construction Management R 3RW 20 0
23 Lainey UG BS  Marketing8S Marketing FR 3 RE 19 o
24 Charbie UG BS B E 8 R 3 RW 13 0
25 Brandon UG BS  Marketing S Marketing R 3RW 28 0
26 Madalyn UG BS B 2 R 3RW 12 o
27 Nemeri UG BS  Management-8S Management R 3RW 18 )
28 Louie UG BIS 8IS ) R 3 AW 3 o
29 Jack UG BS  Construction Management-BS  Construction Management R 3RW 17 0
30 Pray UG AA* Comerstone 2-A4 * Comerstone Program * R 3RW 30 o
31 Amiryana UG AA* Comerstone 2-AA* Cornerstone Program * R 3RW @2 )
32 Micah UG 8BS 8S-747 s0 3 AW 7 o
33 Save UG BS  SpecialEd: Lbd And Eim Edu-8S Special Ed: LBDandEimEdu  FR 3 RE 8 o
34 Jaquis UG BS  Construction Management-BS  Construction Management ] 3RW 25 o
35 Riey UG BS  Marketing BS Marketing R 3RW 21 o
3% Donavan UG 8S Engr Tech BS E Tech SO 3RW 29 0
37
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